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1 Scope 

MicroXCT-400 helps advance innovation in science and industry to provide insight in 3D into the 

internal structure of samples in a large variety of applications. This SOP covers basic operating 

practices for the MicroXCT-400, including preparing the sample, optimizing machine parameters, 

setting up a scan and reconstruction process. The materials captured within this scope are not 

intended to replace the operating Manual for the MicroXCT-400 but only act as a basic overall 

guide of use to this particular piece of equipment. The MicroXCT-400 has many other capabilities, 

but only the general capability which is useful for CRN lab is listed in this SOP. It should be noted 

that image processing is not included in this SOP. 
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2 Summary 

This document outlines the considerations to be taken when operating the MicroXCT-400. First, 

safety instructions and maintenance considerations are noted in titles 4 and 5. Then, different 

components of the test are listed in title 6. Following that, sample preparation and testing 

procedures are explained in titles 7 and 8.  
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3 Interferences 

Details listed within this SOP are based on the “MicroXCT-200 and MicroXCT-400 User’s guide” 

prepared by Xradia. The aforementioned document will be addressed as “the Manual” in this SOP. 

It is highly recommended to refer to this document in case of any unclarity in this text.  
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4 Safety 

The main safety precautions that one should take when operating the equipment are as follows: 

• Users of MicroXCT must be sufficiently trained regarding how to use the machine. 

• The MicroXCT uses 40 to 150 kV X-rays for imaging. The potential hazards of this beam 

include: high voltage, ionizing hazard, pinch hazard and magnetic field. 

• Although the X-ray source automatically turns off when the access doors are open, ensure 

that the access doors are completely closed and not blocked before turning on the X-ray 

source. 

• The EMO shutdown process (pressing the EMO button) can damage the MicroXCT, 

particularly the Workstation and optional storage server, potentially causing data loss and 

irreversible damage. Use only in the event of a personnel safety or equipment emergency. 

Use of the non-emergency shutdown procedure is recommended in non-emergency events. 

• Always keep the MicroXCT room at 70 °F. 

4.1 Shutting down the MicroXCT in a non-emergency event 

 Follow these steps: 

1. On the Workstation, close any programs that are running. 

2. Select Start > Shut Down 

3. After the Workstation is shut down, firmly press the EMO button to turn off the power to 

the microXCT. 

4.2 Turning ON the MicroXCT 

Follow these steps: 

1. Turn the EMO button clockwise until it pops upward. This releases the EMO button and 

enables the use of the RESET button. 

2. Press the RESET button to turn ON the MicroXCT. The green light on the light tower 

should turn on. 

3. Press the Workstation’s Power button to turn on the MicroXCT Workstation. 

4. When you start XMController, you should expect the “Homing” process of the axes. 
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5 Maintenance and Calibration 

The Maintenance and calibration of the device should be done by Carl Zeiss Canada Limited (45 

Valley brook Drive, Toronto, M5B 2S6). For any service call, please contact the service team 

Zeiss Service: 

• Email: service_canada@zeiss.com 

• Phone: 1-800-387-0138 

Also, the person who is in charge of the Maintenance of the UBC’s device is Jon Kostenchuk 

(jon.kostenchuk@zeiss.com). 
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6 Apparatus 

The MicroXCT includes the hardware and software needed to create tomography images and to 

view them. The main components of MicroXCT -400 are shown in the following Figures. 

 

Figure 6-1 MicroXCT-400 external view 

 

Figure 6-2 MicroXCT-400 Internal View 
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6.1 Source 

The 150 kV X-ray source generates X-rays from 40 to 150 kV. It also includes a holder for 

installing a filter – material that improves reconstructed image quality by removing low-energy X-

rays that do not provide useful information through the sample. If MicroXCT power or the X-ray 

source has been turned off for more than eight hours, the X-ray source must go through an initial 

warm-up process, called X-ray source aging. This process can take 30 minutes or more. 

6.2 Detector Assembly 

The detector assembly (also called detector or lens) picks up X-ray images of the samples. There 

are currently 5 magnification lenses installed on the detector assembly. 

 

Table 6-1 Spatial resolution and FOV ranges by magnification level 

Magnification lens Resolution range (µm) 3D FOV Range (mm) 

Macro lens (0.39x) 20.0 – 50.0 17.0 – 50.0 

1x 9.0 - 22.0 4.0 – 15.0 

4x 5 – 6 2.4 – 6 

10x 2.5 - 3 2.0 – 2.7 

20x 1.5 1.3 

 

6.3 Ergonomic station  

It includes a Workstation monitor, shortcut keys for −90° and 0°, joystick for visual positioning, 

visual light camera light switch, mouse, wrist pad and keyboard. (Figure 6-3) 
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Figure 6-3 some of the components of Ergonomic Station 

 

6.4 Software Control 

MicroXCT uses the following three programs to control the X-radia tomography process: 

• XMController  

XMController is the program used to manage the data acquisition process, from setting up 

the sample to the acquisition of data. 

 

• XMReconstruct  

XMReconstruct is the program used to reconstruct all the 2D images (projections) acquired 

during data acquisition/tomography to create a 3D reconstructed volume. 

  

• VisibleLight  

This software controls the visible light camera. 

shortcut keys for −90° and 0° 

joystick for visual positioning 

visual light camera light switch 
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7 Sample Preparation 

In MicroCT imaging, the sample will rotate during the scan, so it’s very important to mount the 

sample in a way that it doesn’t have any unwanted moves. The sample will be fitted in a sample 

holder and then placed on a platform within the scanner. There are multiple sample holders for 

different types of samples. They can be found in the drawers below the working table. The list of 

samples holders with their images can be found in Table 7-1.  

 

Table 7-1 list of sample holders 

sample 

holder 

image sample type 

Clamp 

 

Flat samples no thicker 

than 10 mm like fabric 
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Clip 

 

Flat and rigid samples no 

thicker than 5 mm

 

Pin vise 

 

Thin long samples that are 

3 mm or less in diameter 

 

Sample base  Soft biological material that 

fits within a tube that is 

temporarily attached to the 

sample base 

 

In general, samples should be placed in/on their sample holders in such a manner that the region 

of interest in the sample is: 

• Located above the top surface of the holder 

• Positioned so that the least amount of material is penetrated by X-ray 
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Additionally, the sample must be: 

• Securely mounted in/on the holder 

• Stable such that it does not move nor vibrate in response to a gentle tapping on the holder. 

 

For MicroXCT-400, the diameter and width limitations are 500 mm, and the height limitation is 

400 mm. The recommended sample thicknesses for 3 different magnification lenses are shown in 

Table 7-2. 

 

Table 7-2 recommended maximum solid sample thickness  

Magnification Lens Recommended maximum thickness 

4X 50 mm 

10X 30 mm 

20X 10 mm 
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8 Method 

Before starting a scan, look into the excel datasheet to find similar materials/samples that were 

scanned before. The scan properties of similar materials can give you a good idea about your scan. 

If it’s a new material, look in articles to find the optimized parameters that previous researchers 

have used for their scans.  

8.1 Initial positioning of sample, source and detector 

The directions and movement of sample, detector and source are described and illustrated in  Table 

8-1. The X and Z directions in this table correspond to theta=0. For Theta=90, their movement 

switch. 

 

Table 8-1 sample, detector and source movement directions 

axis movement Movement from the user’s perspective 

X Toward and away from the visual light (9𝟎°) IN and OUT 

Y From top to bottom of the enclosure UP and DOWN 

Z Beamline from the X-ray source to the 

detector (@ 𝟎°) 

LEFT and RIGHT 

theta Circular angle CLOCKWISE and COUNTERCLOCKWISE 
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8.1.1 Loading sample holder assembly onto the sample stage 

1. Start XMController on the computer 

2. Open the Motion Controller by clicking on . This dialog box has 3 tabs: Sample, 

Source, Detector.  

3. Bring the sample stage to the center of the axis of rotation  by entering 0 into the four boxes 

shown in the Sample tab of Motion Controller and then clicking GO. 

4. Select the Source tab of Motion Controller and bring the source to −130. 

5. Select the Detector tab of Motion Controller and bring the detector to 130. 

6. Ensure the X-ray source is OFF. The X-ray source is ON if the red light on the light tower 

is illuminated. If the source is ON, open the X-ray source dialog box by clicking on 

and clicking on On/Off button in front of X-ray indicator. (Figure 8-2) 

 Sample Theta = 𝟎° Sample Theta = 𝟗𝟎° 

Arrangement of 

sample stage 

  

Image View   
Y 

X 

Y 

Z 

X 

X 

Z 

Z 
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7. Open the access door. The Interlock indicator in the X-ray Source dialog box indicated 

OPEN. 

8. Place the sample holder assembly on the sample stage with the flat edges of the assembly. 

The slotted grooves on the assembly should match and help the assembly onto the three 

tungsten alignment balls on the sample stage. 

9. Close the access door. The interlock indicator in the X-ray source dialog box indicates 

CLOSED. The yellow light on the light tower turns ON.  

 

a) Sample tab b) Source tab c) Detector tab 

 
  

Figure 8-1 Motion Controller dialog box 
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Figure 8-2 X-ray Source dialog box 

 

8.1.2 Coarsely positioning the sample 

Now that the sample is in place, it is necessary to ensure that the region of interest in the sample 

is clearly in view. Follow the following steps to coarsely position the sample using the visual light 

camera and motion controller. 

1. Open the Visible Light software on the computer. 

2. Turn on the visual light camera light using the switch on the ergonomic station (Figure 

6-3). 

3. Open the motion controller dialog box and select the Sample tab. 

4. Center the sample’s region of interest in the visual light camera window at 0° and 90°. You 

can use the joystick or enter numbers manually in the textbox of the Motion controller 

window.  

8.1.3 Selecting the lowest magnification  

Now it’s time to visualize the sample at the largest field of view using the lowest magnification. 

To do that, click the drop-down arrow to the right of  and select 0.39 Macro lens.  
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8.1.4 Coarsely positioning the detector 

For fastest imaging, shortest exposure time and greatest intensity in the X-ray image, the detector 

should be coarsely positioned near the sample but not too close that the sample collides with the 

detector in the Z position.  

1. Make sure the X-ray is off and open the doors.  

2. Rotate the sample to −90°, and in the motion control dialog box, detector tab, type a value 

between 20 to 120 in the textbox and click GO. 

3. Continue to change the value by typing decreased values in small incremental steps while 

monitoring the distance between sample and detector. Bring the detector as close as 

possible. Rotate the sample to 0° and check to ensure that the detector does not collide with 

the sample during a 360° full rotation. 

8.1.5 Verifying the X-ray sources position 

1. Select the source tab in the motion controller dialog box.  

2. The source's current position must be -130.  

8.2 Selecting the first tomography location 

8.2.1 Turn on the X-ray Source 

Close the access doors and make sure the yellow light on the light tower turns on. Open the X-ray 

source dialog box and click on the ON/Off power button. The green light on the light tower must 

turn on. Type the appropriate voltage and power in the textbox according to Table 8-2 and click 

APPLY.  

 

Table 8-2 Voltage and Power settings 

Sample Material Type Voltage (kV) Power (W) 

High density 140 10 

Low density 80 10 
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8.2.2 Acquiring continuous images 

Continuous imaging makes it possible to locate the region of interest in a sample and to move the 

region of interest to the center of the FOV by double-clicking. To acquire continuous images:  

1. Click    in the icon bar. The Acquisition Setting dialog box opens. (Figure 8-3) 

2. Select the Camera Settings as follows: Exposure time: 3 sec, Binning: 1, Readout speed: 

fast 

3. Click Start Acquisition to acquire images. A Status message box opens, indicating real-

time acquisition status. And Image Window opens showing the image being updated with 

light intensity counts indicated in blue at the lower left status bar of the Window. Figure 

8-4 

 

Figure 8-3 Acquisition Setting Dialog box 

 

❖ Note that the Camera Temperature should be ≤ 55℃ in the Acquisition Setting Dialog 

box. Contact Xradia Support Team if the temperature is higher.  
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Figure 8-4 Image Window 

 

4. Move the mouse pointer over the image and look at the region of interest’s light intensity 

counts. Resolve any issues with the image being too bright or too dark based on Table 8-3. 

 

Table 8-3 image issues 

issue with image process 

The image is too bright 
If the light intensity count is higher than 

60,000, you must reduce the power. 

The image is still too bright Reduce the exposure time 

The image is too dark Increase the exposure time 

 

Light intensity count 

coordinates 
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5. To close the message box, click on the STOP sign in the icon bar to abort continuous 

imaging. 

6. To continue acquiring images using the same acquisition settings, click  in the icon 

bar. 

 

8.2.3 Identifying the first tomography location 

1. Select View > Highlight Center of FOV. Yellow cross-hairs highlighting the center of the 

FOV is added to the active Image window. (Figure 8-4) 

2. Click  in the icon bar to open the Motion controller dialog box. 

3. In the Sample tab, verify that the Sample Theta is at 0°. 

4. In the image window, locate the region of interest and double-click it using the mouse 

pointer to move the region of interest to the center of the cross-hairs. 

5. Rotate the sample to +90°.  

6. Double-click along the horizontal yellow crosshair to center the region of interest in the 

FOV cross-hairs for the Z-axis. 

7. Change the magnification lens to your desired one based on the required resolution and 

region of interest in Table 6-1. 

8. To verify that the region of interest is still visible in the FOV, bring the center of the region 

of interest to the center of the image by double-clicking on the intersection of the yellow 

cross-hairs at Sample Theta = +90° and 0°. 

 

8.2.4 Finely positioning the detector 

This process describes how to position the detector as close to the sample as possible while 

avoiding collision for the shortest scan time.  

1. Turn off the X-ray source. Make sure the X-ray indicator in the X-ray Source dialog box 

changes to green and the red light on the light tower turns off. 

2. Open the access door. 
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3. In the Motion Controller dialog box, select the Detector tab. Type a value smaller than the 

current camera Z position and keep decreasing the value in 1-mm steps. At the same time, 

keep track of the detector’s position by constantly looking at it.  

4. Ensure the detector does not collide with the sample at Sample Theta = −180°, −90°, 0°, 

90° and during the rotation. This is especially important for cubic samples that have a 

diagonal greater than each side. 

5. Note the current camera Z position (at 0°) in the Motion controller dialog box Detector tab. 

This information can be useful later to calculate source Z's position. 

❖ Moving the detector closer to the sample results in a larger FOV and larger pixel size.  

 

8.2.5 Finely positioning the X-ray source 

This process describes how to use the motion controller to position the X-ray source appropriately 

for imaging with the chosen magnification lens: 

• 10X and 20X: The X-ray source is placed as close to the sample as possible while avoiding 

a collision. 

• Macro, 1X and 4X lenses: The X-ray source is placed such that the distance between the 

X-ray source and detector is not less than that indicated in Table 8-4. This distance is equal 

to Detector Z – Source Z. 

 

Table 8-4 Minimum distance between X-ray source and detector for different lenses 

Lens The minimum distance between X-ray source and detector 

Macro 135 mm 

1X 33 mm 

4X 13 mm 

 

To finely position the X-ray source: 

1. In the Motion Controller dialog box, select the sample tab, type 0 in the Sample Theta text 

box. 
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2. Keep track of the source’s position by constantly looking at it while the X-ray source is 

turned off and the access door is open.  

3. For 10X and 20X, skip stepping 4. For Macro, 1X and 4X, calculate the closest source 

position based on the minimum distance value in Table 8-4 and the Z position of the 

detector. Proceed to step 5. 

4. Bring the source as closest as possible to the sample by following a similar process to steps 

3 in 8.2.4Finely positioning the detector8.2.4.  

5. Ensure the source does not collide with the sample at Sample Theta = −180°, −90°, 0°, 

90° and during the rotation. This is especially important for cubic samples that have a 

diagonal greater than each side. 

 

8.2.6 Selecting and installing the X-ray source filter 

Source filters are materials that improve reconstructed image quality by removing low-energy X-

rays that do not provide useful information through the sample, also referred to as hardening the 

X-ray, thus reducing the effects of beam hardening. To understand whether a filter is required or 

not, the transmission value needs to be calculated. Transmission value is the ratio of X-rays 

through the sample versus the X-rays without the sample presence: 

𝑡𝑟𝑎𝑛𝑠𝑚𝑖𝑠𝑠𝑖𝑜𝑛 𝑣𝑎𝑙𝑢𝑒 =  
𝑖𝑚𝑎𝑔𝑒 𝑤𝑖𝑡ℎ 𝑠𝑎𝑚𝑝𝑙𝑒

𝑖𝑚𝑎𝑔𝑒 𝑤𝑖𝑡ℎ𝑜𝑢𝑡 𝑠𝑎𝑚𝑝𝑙𝑒
 

1. Close the access doors, turn on the X-ray source and move the sample to Theta = 0°. In the 

Motion Controller dialog box, note the X, Y, Z position of the sample in case you want to 

move the sample out of FOV by changing the stage position. 

2. Acquire image without sample: Move the sample out of the FOV. Open the Acquisition 

Setting dialog box and acquire a single image with exposure time=10 sec and Bining = 1, 

and Readout speed = fast. Note the image name in the top left corner of the Image window’s 

title bar. 

3. Acquire image with the sample: Move the sample back to its initial FOV. Click   

to acquire a single image with the same acquisition settings selected in step 2. Note the 

image name. 
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4. Calculate the transmission ratio:  

a. Select Process > Image Calculator. The calculator dialog box opens. (Figure 8-5). 

b. Select the 𝑎/𝑏 operation. 

c. Select the image acquired in step 4 (image with sample) from the Input a drop-

down list box. 

d. Select the image acquired in step 3 (image without sample) from the Input b drop-

down list box. 

e. Click calculate. The “Choose Output Format” dialog box opens. Click OK to select 

the Float output datatype.  

 

Figure 8-5 image calculator dialog box 

 

f. An ImageX_Div window opens with a transmission value indicated in blue at the 

lower left status bar of the Window on a scale of 0 to 1. If the transmission value is 

greater than 1, you divided the blank image by the sample image by mistake. The 

transmission value appears in place of the Light intensity count in Figure 8-4. 

g. Using the value determined in Step f, determine the appropriate X-ray source filter 

thickness based on Tables 3-3 and 3-4 of the Manual, which are also attached to the 
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machine’s door. The installation process of the filters is explained in Chapter 3 of 

the Manual.  

8.2.7 Determining the optimum X-ray source Voltage 

This process describes how to determine the modified transmission value after installing an X-ray 

source filter and identify which X-ray source voltage to use to acquire images with minimal beam-

hardening artifacts. 1. If an X-ray source filter is not used, the transmission value is known from 

8.2.6, proceed to step 4. If an X-ray source is used, you need to repeat the process in 8.2.6 to 

calculate the new transmission ratio by following steps 1 to 3. 

1. Acquire image with the sample: Click  to acquire a new image. If the image is too 

dark, with light intensity counts of less than 500, increase the X-ray source power. If it’s 

still too dark, increase the exposure time to 2 times the current value. Note the image name. 

2. Acquire image without sample: Acquire an image without the image with the same 

acquisition settings. 

3. Determine the transmission value using the image calculator as explained in 8.2.6. The 

ideal transmission value should be between 0.23 and 0.35.  

4. If the transmission value is not within the ideal range, use Table 8-5 to adjust the 

value.Table 8-5 transmission value adjustment 

 

Table 8-5 transmission value adjustment 

Transmission value range process 

< 0.23 Increase the source voltage 

> 0.35 Reduce the source voltage 

 

If you have reached the minimum or maximum voltage available on the X-ray source and still 

haven’t reached a transmission value between 0.23 and 0.35, go to 8.2.8.  
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8.2.8 Determining the X-ray source power and exposure time 

This process describes how to adjust the X-ray source power and exposure time used to achieve 

the optimum light intensity counts per projection image. 

• For 10X and 20X: set power to the minimum possible. 

• For Macro, 1X and 4X: set power to maximum possible. 

Adjust the exposure time to acquire as close to 5,000 light intensity counts as possible but no more 

than 30,000. The recommended range is 5,000 to 10,000. Ideally, light intensity counts at the 

region of interest should be higher than 5,000 but less than 30,000. However, anything greater than 

1,000 is acceptable. 

 

8.3 Set up a tomography scan 

8.3.1 Recording the first selected tomography location 

1. Click the Image Window of the last “image with sample” acquired in 8.2. Close all other 

Windows that are open. 

2. Select View > Highlight Center of FOV to add the yellow cross-hairs highlighting to the 

active image. Click  in the icon bar to open the Image control dialog box. Go to the 

Annotation tab. (Figure 8-6). 

3. Click  to access the tomography location tool. 

4. Click the center of the image window at the intersection of the yellow crosshairs. The 

“tomographic location set” dialog box opens. Choose “Add the point to tomographic 

location set,” click on “Clear Existing,” and click OK.  

5. Click  to cancel the Tomography Location tool selection for the image.  
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Figure 8-6 Image Control dialog box – Annotation tab 

 

8.3.2 Setting up a recipe 

1. Turn on the X-ray source and ensure the voltage and power are set t the optimum value 

obtained.If the X-ray source has been turned off for more than 15 minutes, ensure that the 

X-ray source has been turned on for more than 15 minutes to warm up. 

2. Click  to open the Recipe dialog box. (Figure 8-7) 

3. In the “Tomography Locations” panel, click “add the list of tomography locations from 

the current image”. The tomography locations that you selected earlier are added to the 

panel. 

4. Fill out the “Acquisition”, “References,” and “Reconstruction” panels, based on  Figure 

8-7. 

5. In the “Camera” panel, set exposure time equal to the optimized value you found in the 

previous section. Select “fast” and “1” for “readout time” and “binning”, respectively. 
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6.  “Source” and “Magnification” panels will be filled automatically.  

7. In the “saving” panel, set the directory by clicking on “Browse” and type a name in the 

File base name textbox. 

8. You can check the estimated tomography time in the “time and space required” panel. To 

start the recipe, click on “run current recipe”. 

9. Make sure the interior light is turned off. 

10. Enter the scan’s specifications in the excel sheet on the VIS1 computer. 

 

 

Figure 8-7 Recipe dialog box 
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8.4 Reconstruction 

The process of computing the internal structural information from the projection images is known 

as reconstruction. This procedure results in a stack of reconstruction images (cross-sectional 

images” or “slices”). 

8.4.1 Preparing for reconstruction 

1. Open “XMReconstructor” software. 

2. File > Open or click on  

3. Browse the destination file path and open the large .txrm file. (Figure 8-8) 

 

Figure 8-8 XMReconstruct main window 

 

8.4.2 Finding center shift 

Center shifts are the amount in pixels that the axis of rotation is offset from the center column of 

the detector. Images with the good center shifts are focused and clear, while images with the bad 

center shifts are unfocused and blurry. 
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1. Click . The Rotation center/beam hardening dialog box opens. (Figure 8-9) 

2. Click and drag the red line to cross a high contrast feature to select the slice. 

3. Set: 

a. Binning: 1 

b. Start shift: -20 

c. Step to shift: 5 

d. End shift: +20 

e. Beam hardening contrast: 0 

 

Figure 8-9 Rotation center/beam hardening dialog box 

 

4. Click OK. A reconstruction status message box opens, indicating real-time reconstruction 

status, and a reconstructed slice image window opens. Images will be added to the same 

Window as the reconstruction status proceeds. The center shift of each image can be found 

on the top left of the Window. 

5. When finished, check out all the images by scrolling the bar at the bottom of the image. 

Choose the best slice. Redo 3 and 4 repeatedly in the range close to the best image to find 
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the most focused image and the value for the center shift. In each repeat, lower the “step 

for shift”. 

6. In the case where there are areas on the image that are all white and black, image contrast 

and brightness should be adjusted such that detailed features within the all white/black 

areas can be observed. Check the manual page 166 for more details. 

 

8.4.3 Finding beam hardening correction 

Beam hardening is the result of the change in spectrum characteristic as the Xray passes through 

the sample, where the sample density remains the same, but light changes – one area is darker than 

another. To identify beam hardening correction, look at the manual page 168-173. 

8.4.4 Reconstructing the tomography data 

1. Open the Reconstruction Setting dialog box by clicking on . Reconstruction Setting 

Dialog box opens () 

2. Select the output folder by clicking on the three dots below “Output File Name”. 

3. Output mode: TIFF 

4. In the Center shift panel, enter the optimized center shift. 

5. Output data type: 8bit 

6. Binning: 1 

7. Defect Correction: bright and dark spots 

8. Click OK. 

9. It usually takes about 2 hours. When the reconstruction is complete, the Reconstruction 

Status window closes, and a Message dialog box opens indicating the total reconstruction 

time.  

10. Enter the center shift in the excel datasheet. 
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Figure 8-10 Reconstruction Setting Dialog box 

 

8.5 Image processing 

While the tomography is reconstructed, the cross-sections can be seen as TIFF files. Further image 

processing can be done in Avizo, Dragonfly or FIJI/ImageJ. Avizo has many YouTube videos and 

a good manual that helps the users to learn different features. The the folder sradiadata on Micro-

CT computer is accessible from one of the image processing stations in EME0201C through 

Network. The username and password of both staions are: 

Username: .\vis1 

Password: vis1vis1 

Also, the network access passcode is: P@ssw0rd 
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